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Microsoft Excel is a spread sheet program that makes it easy for you to create, 

track, and update all sorts of data. Excel’s calculating functions are ideal for 

creating products, such as inventories, check registries, or sales invoices.  

 

1. Getting Started 

Terms 

Before we even learn about the “Excel” program itself here are a few keywords that 

you will hear frequently hear during your sessions: 

Mouse:  A device that allows you to select onscreen items by pointing at them with the  

              mouse pointer. A mouse is connected to the computer by a long, thin cord that   

              resembles a mouse tail – hence the name. 

Spreadsheet: Also known as worksheet, a spreadsheet is a grid composed of rows 

                 and columns that intersect to form cells. You enter data (text, numbers  

                 and formulas) into these cells, and the spreadsheet performs calculations on  

                 the data. 

Active Cell:  The cell in which the cursor (or cell pointer) is currently located. A cell  

                       must be active in order for you to enter data into it.  

Cell Pointer: A dark border around a cell in a worksheet, indicating that it’s the active   

                       cell. You can move the cell pointer with the mouse or the keyboard. 

Menu: A list of commands. You’ll find a program’s menu located at the top of the                    

            program window, just below the title bar. 

Toolbar: A long bar or row of buttons (small pictures) that represent various commands. 

 

Opening Excel: 

In order to open the Microsoft Excel program you must: 

Click the  button in the lower left corner of the screen. 

Click on the option “All Programs” 

Scroll down and click on “Microsoft Office” as shown. 
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                                                                                                          Click on this option 

 

Once you click in Microsoft Office, simply select Microsoft Office Excel 2009 in the 

drop-down menu. 

Once opened, the Excel screen should look as follows. 
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                                                                                                                               Close 

               Formula bar                                                                       Maximize/ Restore 

 

                                                      Column Heading 

Row Heading                                                                                                     Minimize  

 

 

 
                                 Status Bar                                               Horizontal and vertical Scroll bars 

 

Cell 

 

The Excel Window contains many parts: 

Scroll Bars:  Used to display a part of a worksheet that is currently hidden from view –  

                      there is a horizontal and vertical scroll bar. 

Formula Bar: Provides an area for entering and changing cell data and reviewing cell   

                        formulas 

Row Headings:  Contains numbers for each row in the worksheet. Rows are labeled 1, 2,  
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                          and 3 and so on. A worksheet usually contains 1,048,576 rows. 

Column Headings: Contain letters for each column in the worksheet. Columns are  

                                labeled A to Z then AA to AZ and so on. Worksheets usually contain   

                                16,384 columns. 

Cell: The intersection of a column and a row. The active cell is marked with a dark  

           outline. A cell’s address is composed of its column letter followed by its row  

            number, as in cell B3. 

Status Bar: Displays the current status of the workbook, along with other data, such as    

                    The sum of the selected cells.  

 

Getting Familiar with Excel 

The Title Bar  

 

This lesson will familiarize you with the Microsoft Excel screen. We will start with the 

Title bar, which is located at the very top of the screen. On the Title bar, Microsoft Excel 

displays the name of the workbook you are currently using. At the top of your screen, you 

should see "Book1 – Microsoft Excel" or a similar name. 

The Office Button 

 

The Office Button is located on the upper left corner of 

the Microsoft Excel screen. Once clicked, a drop-down 

menu appears with the commands New, Open, Save, 

Save As, Print, Prepare, Send, Publish and Close. We 

will discuss each of these commands throughout the 

lessons. You use the Office Button to give instructions to 

the software, to be applied in the current book or project. 
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Point with your mouse to a menu option and click the left mouse button. To select an 

option, highlight the item on the drop-down menu and press Enter. An ellipse after a 

menu item signifies additional options; if you select that option, a dialog box will appear.  

Do the following exercise, which demonstrates using the Microsoft Excel menu.  

1. Point to the Office Button with your mouse.  

2. Click your left mouse button.  

3. Press the down arrow key until Close is highlighted.  

4. Press the Up arrow key until Print is highlighted.  

5. Press the right arrow key once.  

6. Press the down arrow key until Quick Print is highlighted.  

7. Now simply click on the Office Button once more.   

Tabs 

 
Home Tab 

  

 
Insert Tab 

Page Layout Tab 

Formula Tab 

Data Tab 
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Review Tab 

View Tab 

Tabs provide shortcuts to menu commands. Toolbars are generally located just below the 

Title Bar. 

Worksheets  

 

Microsoft Excel consists of worksheets. Each worksheet contains columns and rows. The 

columns are lettered A to XFD; the rows are numbered 1 to 1,048,576 rows. The 

combination of column and row coordinates make up a cell address. For example, the cell 

located in the upper left corner of the worksheet is cell A1, meaning column A, row 1. 
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Cell D10 is located under column D on row 10. You enter your data into the cells on the 

worksheet.  

 

The Formula Bar  

 

If the Formula bar is turned on, the cell address displays on the left side of the Formula 

bar. Cell entries display on the right side of the Formula bar. Before proceeding, make 

sure the Formula bar is turned on.  

1. Point to the View Tab, which is located under the Title Menu.  

2. Click the left mouse button. The View toolbar will show up. 

3. On the Show/Hide, check if Formula Bar has a checkmark next to it. If not, 

simply click on the square to place a checkmark on it. Click back to the Home tab. 

4. Note that the current cell address displays on the left side of the Formula bar.  
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Selecting Cells 

 

If you wish to perform a function on a group of cells, you must first select those cells by 

highlighting them. To highlight cells A1 to E1:  

1. Place the cursor in cell A1.  

2. Press the F8 key. This anchors the cursor.  

3. Note that “Extend Selection” appears on the Status bar in the lower right corner of 

the screen. You are in the Extend mode.  

4. Click in cell E7. Cells A1 to E7 should now be highlighted.  

5. Press Esc and click anywhere on the worksheet to clear the highlighting.  

Alternative Method - Selecting Cells by Dragging  

You can also highlight an area by holding down the left mouse button and dragging the 

mouse over the area. In addition, you can select noncontiguous areas of the worksheet by 

doing the following:  
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1. Place the cursor in cell A1.  

2. Hold down the Ctrl key. Do not release it until you are told. Holding down the 

Ctrl key enables you to select noncontiguous areas of the worksheet.  

3. Press the left mouse button.  

4. While holding down the left mouse button, use the mouse to move from cell A1 to 

E7.  

5. Continue to hold down the Ctrl key, but release the left mouse button.  

6. Using the mouse, place the cursor in cell G8.  

7. Press the left mouse button.  

8. While holding down the left mouse button, move to cell I17. Release the left 

mouse button.  

9. Release the Ctrl key.  

10. Press Esc and click anywhere on the worksheet to remove the highlighting 

 

 

 

Entering Text  

In this lesson you are going to learn how to enter text.  To begin, open Microsoft Excel. 

For this lesson, your default font should be set to Arial. Let’s check to make sure it is.  

1. Make sure you are in the Home Tab, and find the Font group. 

2. Make sure it reads “Arial” in the font bar. If not click the down arrow and select 

Arial. 
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This lesson will teach you how to enter data into your worksheet. First you place the 

cursor in the cell in which you would like to enter data, type the data, and then press 

Enter.  

1. Place the cursor in cell A1.  

2. Type John Jordan. Note that the word Ready on the Status bar changes to Enter.  

3. The Backspace key erases one character at a time. Erase "Jordan" by pressing the 

backspace key until Jordan is erased.  

4. Press Enter. The name "John" should appear in cell A1.  

 

Editing a Cell  

After you enter data into a cell, you can edit it by pressing F2 while you are in the cell 

you wish to edit.  

1. Move the cursor to cell A1.  
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2. Press F2. Note that the word Ready on the Status bar changes to Edit.  

3. Change "John" to "Jones."  

4. Use the backspace key to delete the "n" and the "h."  

5. Type nes.  

6. Press Enter.  

 
 

Alternate Method – Editing a Cell by Double-Clicking in the Cell  

You can change "Jones" to "Johnson" as follows:  

1. Move the cursor to cell A1.  

2. Double-click in cell A1.  

3. Press the End key. That will place the cursor at the end of your text.  

4. Use the backspace to erase "n," "e," and "s."  

5. Type hnson.  

6. Press Enter.  
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Formatting Cells 

Formatting cells allows you to change the way in which the cell displays the information 

you enter. Cells can be formatted to show the numbers in many different ways. To begin 

to format a cell, follow these steps: 

1. Type the number 98467 in cell C1 and press enter 

2. Locate the Number bar in the Home tab. 

 

3. Click on the comma sign  to use the 1000 separator 
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4. The number in cell C1 should now read 98,467.00  

5. Now the cell needs to be formatted again to show that it is a monetary value. 

6. Click on the box on top of the comma, in the number bar. 

7. Press the down arrow key to see the drop-down menu. 

8. Select the Currency option on the drop-down menu 

9. Leave the symbol as a “$” and click Ok. 

10. Cell C1 should now read $98,467.00 

Formatting Dates 

1. Put the cursor on cell C2 

2. Click on the box on top of the comma. The same one we used before. 

3. Press the down arrow key until Cells is highlighted. 

4. Click on “More Number Formats.” 

5. Under type click on *Wednesday, March 14, 2001 and click Ok 
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6. Now in type 7/4/99 in cell C2 and hit enter. 

 

7. Cell C2 should now read Sunday, July 04, 1999. Notice how the formatting 

automatically changed the way in which the date is displayed but the Formula Bar 

shows the date still as 7/4/1999. 

8. Similar procedures are used to format cells to show times and percentages. 

Adjusting the Standard Column Width  

When you enter Microsoft Excel, the width of each cell is set to a default width. This 

width is called the standard column width. We need to change the standard column width 

to complete our exercises. To make the change, follow these steps:  

1. Click on Format, which is located on the Cells slot in the Home tab.  

2. Press the down arrow key until Default Width… is highlighted.  

3. Press Enter.  

4. Type 25 in the Standard Column Width field.  

5. Click on OK. The width of every cell on the worksheet should now be set to 25.  

Cell Alignment  

Look at cell A1. The name "Cathy" is aligned with the left side of the cell. You can 

change the cell alignment.  
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Centering by Using the Alignment Group 

To center the name "Cathy," follow these steps:  

1. Move the cursor to cell A1.  

2. Click on the Center icon, which is located on the Alignment Group. 

 
The red circle designates the Align Center icon.  

Right-Aligning by Using the Alignment Group 

To right-align the name "Cathy," follow these steps:  

1. Move the cursor to cell A1.  

2. Click on the Align Right icon, which is located on the Formatting toolbar.  

 
The red circle designates the Align Right icon.  

Left-Aligning by Using the Alignment Group 

To left-align the name "Cathy," follow these steps:  

1. Move the cursor to cell A1.  

2. Click on the Align Left icon, which is located on the Formatting toolbar.  
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The red circle designates the Align Left icon.  

 

 

 

 

Adding Bold, Underline, and Italic 

 

Adding Bold by Using the Icon  

1. Type Bold in cell A3.  

2. Click on the checkmark located on the Formula bar.  

3. Click on the Bold icon, which is on the Formatting toolbar.  

4. Click again on the Bold icon if you wish to remove the bolding.  

Alternate Method – Adding Italic by Using the Icon  

1. Type Italic in cell B3.  

2. Click on the checkmark located on the Formula bar.  

3. Click on the Italic icon, which is on the Formatting tab.  

4. Click again on the Italic icon if you wish to remove the italics.  

Alternate Method – Adding Underline by Using the Icon  

1. Type Underline in cell C3.  

2. Click on the checkmark located on the Formula bar.  

3. Click on the Underline icon, which is on the Formatting tab.  

4. Click again on the Underline icon if you wish to remove the underline.  

Alternate Method – Bold, Underline, and Italicize Using Icons  
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1. Type All Three in cell D3.  

2. Click on the checkmark located on the Formula bar.  

3. Click on the Bold icon.  

4. Click on the Italic icon.  

5. Click on the Underline icon.  

 

Changing the Font and Font Size 

You can change the Font and Font Size of the data you enter.  

1. Type Times New Roman in cell A5.  

2. Click on the checkmark located on the Formula bar.  

3. Click the font box in the Font Slot. 

4. Click on  and select Times New Roman. This will change you current font to 

Times New Roman 

 

Changing the Font Size 

1. Place the cursor in cell A5.  

2. Click on the box next to the font. It should have a number in it.  

3. Click on  and select 15 in the Size Box  

Deleting a Cell Entry  

To delete an entry in a cell or a group of cells, you place the cursor in the cell or highlight 

the group of cells and press Delete.  

1. Place the cursor in cell A5.  

2. Press the Delete key.  
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Changing a Single Column Width 

1. Place the cursor on the line between the B and C column headings. The cursor 

should look like  with two arrows. 

2. Move your mouse to the right while holding down the left mouse button. The 

width indicator will appear on the screen.  

 

3. Release the left mouse button when the width indicator shows approximately 40.  

Moving to a New Worksheet  

In Microsoft Excel, each workbook is made up of several worksheets. Before moving to 

the next topic, move to a new worksheet.  

1. Click on Sheet2, which is located in the lower left corner of the screen.  
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Filling Cells Automatically  

You can use Microsoft Excel to automatically fill cells with information that occur in a 

series. For example, you can have word automatically fill in times, the days of the week 

or months of the year, years, and other types of series. The following demonstrates:  

1. Type the following into the worksheet as shown.  

 

2. Place the cursor in cell A1.   

3. Press F8. This will anchor the cursor.  

4. Press the right arrow key six times to highlight cells A1 through G1.  

5. Find the small black square in the lower right corner of the highlighted area. This 

is called the Fill Handle.  

 

6. Grab the Fill Handle and drag with your mouse to highlight cells A1 to G24.   

7. Note how each cell fills.  
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2. Press Esc and then click anywhere on the worksheet to remove the highlighting.  

Numbers and Mathematical Calculations  

In this lesson you will learn how to work with numbers and how to perform mathematical 

calculations. To begin, open Microsoft Excel.  

Making Numeric Entries  

In Microsoft Excel, you can enter numbers and mathematical formulas into cells. When a 

number is entered into a cell, you can perform mathematical calculations such as 

addition, subtraction, multiplication, and division. When entering a mathematical 
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formula, precede the formula with an equals sign. Use the following to indicate the type 

of calculation you wish to perform:  

+ Addition  

- Subtraction  

* Multiplication  

/ Division  

 

Performing Mathematical Calculations  

The following exercises demonstrate how to perform mathematical calculations.  

Addition  

1. Move the cursor to cell A1.  

2. Type 1.  

3. Press Enter.  

4. Type 1 in cell A2.  

5. Press Enter.  

6. Type =A1+A2 in cell A3.  

7. Press Enter.  

8. Note that cell A1 has been added to cell A2 and the result is shown in cell A3.  

 

Place the cursor in cell A3 and look at the Formula bar.  
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Subtraction  

1. Press F5. The Go To dialog box will appear.  

2. Type B1.  

3. Press Enter.  

4. The cursor should move to cell B1.  

5. Type 5 in cell B1.  

6. Press Enter.  

7. Type 3 in cell B2.  

8. Press Enter.  

9. Type =B1-B2 in cell B3.  

10. Press Enter.  

11. Note that cell B2 has been subtracted from B1 and the result is shown in cell B3.  

 

Place the cursor in cell B3 and look at the Formula bar.  

Multiplication  

1. Hold down the Ctrl key while you press "g" (Ctrl-g). The Go To dialog box will 

appear.  

2. Type C1.  

3. Press Enter. You should now be in cell C1.  

4. Type 2 in cell C1.  

5. Press Enter.  

6. Type 3 in cell C2.  

7. Press Enter.  

8. Type =C1*C2 in cell C3.  
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9. Press Enter.  

10. Note that C1 is multiplied by C2 and the answer is displayed in C3.  

 

Place the cursor in cell C3 and look at the Formula bar.  

Division  

1. Press F5.  

2. Type D1.  

3. Press Enter. You should now be in cell D1.  

4. Type 6 in cell D1.  

5. Press Enter.  

6. Type 3 in cell D2.  

7. Press Enter.  

8. Type =D1/D2 in cell D3.  

9. Press Enter.  

10. Note that D1 is divided by D2 and the answer is displayed in cell D3.  

 

Place the cursor in cell D3 and look at the Formula bar.  

 

The AutoSum Icon  

The AutoSum icon on the Home Tab in the Editing group, it automatically creates a SUM 

function. The following illustrates using the SUM function to total the Region 1 sales:   
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1. Press F5.  

2. Type B16.  

3. Press Enter.  

4. Click on the AutoSum button, which is located on the Standard toolbar.   

 
B4 to B15 should now be highlighted.   

 

 

5. Press Enter.  

 

Inserting Rows  

You can use Microsoft Excel to insert or delete rows on the worksheet. You need to 

insert three rows so you can add headings to the chart.   



 

 26 

1. Highlight cells A1 to A3. Move the cursor to cell A1. Press F8. Press the down 

arrow key twice.  

 

2. Click on Insert, which is located on the Menu bar.  

 

3. Press the down arrow key until Rows is highlighted.  

4. Press Enter. Three new rows should be inserted.  

Your worksheet should now look similar to the one shown here.   
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Inserting Columns  

You can use Microsoft Excel to insert or delete columns on the worksheet. You need to 

insert a column.   

1. Move the cursor to cell A4.  

2. Click on Insert, which is located on the Menu bar.  

3. Press the down arrow key until Columns is highlighted.  

4. Press Enter.  

5. A new column is inserted.  
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Using Copy and Paste  

In Lesson Three you learned that you can copy and paste information. To copy the 

formula in cell B16 and paste it in cells C16 to D16, follow these steps:   

1. Move to cell B16.  

2. Click on the Copy icon. Rotating dotted lines will appear around the cell. The 

rotating dotted lines designate the area to be copied.  

3. Highlight cells C16 to D16.  

4. Click on the Paste icon, which is located on the Standard toolbar. The formula in 

cell B16 is copied to cells C16 and D16.  

5. Press Esc.  
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Creating a Border  

You can use the Border icon to place borders around a cell. You have several options on 

the type of border to use and where to place the borders. Borders can be placed above, 

below, and/or on the sides of cells. The following illustrates using borders:   

1. Place the cursor in cell C16.  

2. Highlight cells C16 to F16.  

3. Click on the down arrow next to the Borders icon to open the Borders palette.  

 
 

 

 

 

 

 

 

 

4. Click on Top and Double Bottom Border (farthest right in the middle row).  
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Applying Themes 

In order to be able to create a great-looking workbook without having to spend too much 

time on small details, you may choose to apply a theme to either the whole workbook or 

to specific parts of the workbook, such as tables and graphs. 

To apply a theme to the whole document, follow these instructions; 

1. Click on the Page Layout Tab 

 

2. Now, in the themes group, click on Themes. 
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3. By moving your mouse over any of the built-in themes, you can see a preview of 

how it looks like in the current workbook. 

4. Select one that you like and click on it. The theme will then be applied to your 

workbook. 

If you feel that you may want to use a more personalized theme, you may choose to use 

some of the other commands, such as Effects and Fonts, located next to the Themes 

command. 

 

You can change the colors used, the font and effects to create your own theme design. 

Printing 

If you wish to print what you have in your workbook, you can accomplish this by 

following these simple steps 

1. Select what you want to print (If printing everything you have on the workbook 

skip this step) 

2. Click the Office Button , located on the top left hand corner of the window. 
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3. Click on the Print Command. 

 

4. Hit OK on the printing screen. 

Exit Excel 

You can exit Excel by using the file menu or the close button. If you make any changes 

to your notebook you will be prompted to save the changes 


